
12 September 2011HP Confidential 1

INTRODUCING NONSTOP DEVELOPMENT 

ENVIRONMENT FOR ECLIPSE (NSDEE)

©2010 Hewlett-Packard Development Company, L.P. 
The information contained herein is subject to change without notice

Bert van Es 

NonStop Technology Consultant

MODERNIZE
Your development environment using Eclipse 
and NSDEE



12 September 2011HP Confidential 2

3 ©2011 Hewlett-Packard Development Company, L.P

• Demonstrate how easy it is to use NonStop Development Environment for Eclipse 

(NSDEE) to modernize your NonStop development environment

– Value proposition

– Installation and upgrade

– A few key concepts

– Project creation

– Development workflow: EditBuildDeployDebug

– NSDEE roadmap next steps

• Approach

– A visual tour

– Highlight recent improvements in NSDEE 2.1

Overview
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• Eclipse

– Familiar with Eclipse?

– Using Eclipse?

• NSDEE

– Attended a past NSDEE presentation?

– Using NSDEE?

– Using EPE?

• What languages do you use?

– Java?

– C/C++?

– COBOL?

– pTAL?

– DDL?

– SQL?

About you?
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CUSTOMER PROBLEM

Development has become more complex
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• I don‟t need to tell you, but we are all struggling with the reality of 

– Increasing complexity

– “do more with less”

• Gone are the days of a single platform and single technology stack

– Developers increasingly work with multiple technologies an multiple platforms

– Open source has become a transformational and driving force 

– Pace of technology evolution continues to increase

– Organizations value “standard skills” to reduce training and increase flexibility

– Organizations want to optimize software development cycle time

• Increasingly difficult for proprietary tools to meet these needs

Development Challenges

Challenges
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Development environments are often frozen in time 
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• Once created, development environments 

are rarely updated unless there is a:

– Platform migration

– Significant new project

• Consequences

– Fail to benefit from modern tools

– Harder to hire and retain talent

• Not for lack of desire, but…

migrations can be costly

Development Challenges

Challenges

NonStop has lacked wide selection of current development tools
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• Past tools

– Tandem Extensions for Codewright (TEC)

– Tandem Development Suite (TDS, based on Borland IDE)

• Aging current tools

– Enterprise Toolkit (ETK, based on Visual Studio)

– Visual Inspect 

Development Challenges

Challenges
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Increasingly difficult for proprietary tools to keep up

Challenges

NONSTOP MODERNIZATION
WITH NSDEE
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• All Modern. All Standard. 100% NonStop

• Software Development component

– Embrace standards and open source

– Leverage and extend industry standard tools 

• GDB based debuggers

• Eclipse based Integrated Development Environment (IDE)

– Support SOA adoption

– Support application deployment on scalable run-time with

NonStop fundamentals

NonStop Modernization Initiative

Modernization
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Integrated Development Environment 101
– A GUI for software development

• Simplifies software development workflows 

(editbuilddeploydebug)

• Integrates development tools 

• Language and API aware editing

• Provide information about program structure 

– Benefits

• Simplifies development

• Integrates tools for multiple technologies

• Common interface for multiple platforms

• Reduces application development complexity

– Users

• Some prefer IDEs, some command-line tools

• Not necessarily an either or choice

• Increasingly important to “next gen” 

developers

– Industry leading IDEs:

• Visual Studio – Focused on .NET

• Eclipse – Open source, supports MANY

technology stacks

• NetBeans – Oracle owned; Supports Java, 

C/C++, and scripting languages

Modernization
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• Go forward” NonStop Integrated Development Environment (IDE)

– Supersedes Enterprise Plug-ins for Eclipse (EPE)

– Platform for future IDE functionality; Visual Studio-based ETK is mature

• Eclipse-based

– Industry standard IDE

– Common development desktop for multiple platforms and technologies

– Users benefit from rich ecosystem of extensions 

• Supports

– Windows-based (“local”) development

– NonStop-based (“remote”) development

– IDE Integrated Debugging for Integrity NonStop systems 

Introducing NSDEE

NonStop IDE First!

NonStop IDE First!

Modernization
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The Power of Eclipse

– Leading “open source” IDE

– Architecture
• Java based
• OSGI Component model
• Used as an IDE platform
• Used as a framework for building 
stand-alone applications 

– Runs on many platforms

– Rich plug-in „ecosystem‟

– Innumerable IDE frameworks and 
plug-ins:
• Java Development (JDT)
• C/C++ Development (CDT)
• NSDEE
• SQL Explorer
• UML modeling
• Embedded device development
• …

– Yearly major releases

Modernization



12 September 2011HP Confidential 8

15 ©2011 Hewlett-Packard Development Company, L.P

NSDEE Architecture
• NSDEE Core

– Supports C, C++, COBOL, pTAL

– Local edit and build

– Remote edit and build

• NSDEE Debug 
– Integrated debugging for Integrity NonStop systems

• NSDEE 2.1 builds on eclipse CDT 7 and 
uses Eclipse File System (EFS)

• NonStop Java developers can install the 
standard eclipse JDT 
(now bundled with 2.1)

Modernization
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NSDEE Build Models

• Execute build on NonStop system

– Source files and tools reside on NonStop

– OSS make

– Guardian GMAKE

• Standard make model

• Allows the IDE to be used with legacy 

NonStop applications

• Execute build on Windows 

– Source files reside on Windows 

– Uses NonStop cross-compilers with cygwin make

• Standard make model

– User defines and manages the makefile

– NSDEE defines environment variables

• Managed make model

– IDE uses knowledge of dependencies to generate 

and maintain the makefile

– Useful for small programs, less so for large ones

Local Build NonStop Build

Modernization



12 September 2011HP Confidential 9

17 ©2011 Hewlett-Packard Development Company, L.P

• Windows hosted cross-compiler users

– Can run existing makefiles from NSDEE 

– Can use the IDE while continuing to use command-

line tools 

• Enterprise ToolKit (ETK) users

– Can import existing projects to NSDEE

– Benefit from the cross-platform nature of eclipse 

– Can leverage more third-party extensions

• NonStop hosted users

– First NonStop IDE to support NonStop hosted 

development!

– Build on OSS or Guardian

NSDEE Targets all NonStop developers

• Visual Inspect users

– Benefit from IDE integrated debugger during the 

edit->build->deploy->debug cycle

– Still use Visual Insect for production debugging

• Enterprise Plug-in for Eclipse (EPE) users

– Free upgrade to NSDEE!

Modernization

from Proprietary to Industry Standard Tools

18 Footer goes here

• Challenges

– Tools familiar to long-time developers no longer available

– Sometimes less integrated

– Often have to rely on documentation from several sources

– Tools may have some “rough edges” or lack customizations 

• Benefits

– New capabilities previously unavailable with proprietary 

tools (debugger memory leak detection)

– Increased flexibility

– Faster rate of evolution

– The ability to use the same tools and skills across platforms 

Customer Journey

• Many have started but are at different 

points along the way

• Biggest challenge: embracing CHANGE

• Expectations are key 

• Requires some “give and take”

Modernization
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Installation and Upgrade

19
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• To use NSDEE

– A Windows PC running 32-bit Microsoft 

Windows Vista or Windows XP

– Java run-time, version 5 (or later)

– Eclipse Helios with CDT 7.0.0

• To build local projects

– Cygwin Make package version 3.81 (or later)

– NonStop cross-compilers for the languages 

you want to use

• To debug

– An Integrity NonStop system

– Native Inspect T1237H01^AAT (or later)

• To use SQL/MX

– A NonStop system with SQL/MX compiler

– SQL/MX preprocessors installed on your 

local machine

• To Use SQL/MP

– A NonStop system with the SQL/MP compiler

NSDEE Prerequisites

Installation
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• Java users:

1. Expand eclipse-java-helios-win32.zip

(175 MB)

2. Run Eclipse

3. Use Help->Install New Software… to 

install the bundled version of CDT

• Non-Java users:

1. Expand eclipse-cpp-helios-win32.zip

(89MB)

Installing NSDEE 2.1

Install Base Eclipse

• Run Eclipse

• Use Help->Install New 

Software… to install

– NSDEE-Core.zip

– NSDEE-Debugger.zip *

• Follow readme instructions to install 

CDT patches

Install NSDEE

* If you purchased NSDEE with debugging

Installation
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• EPE users use existing EPE migration wizard

• ETK users use improved ETK migration support 

• NSDEE 2.0 users

– Install the new versions of eclipse and NSDEE 

(you can keep existing versions)

– Create a back-up copy of NSDEE 2.0 projects

– NSDEE 2.1 automatically converts 2.0 projects to 2.1 when loaded

Migrating to NSDEE 2.1

Installation
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NSDEE Welcome Page

Installation

• Displayed when your 
first launch Eclipse

• Help->Welcome

Key Concepts

24Footer goes here
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• Eclipse Perspective – A collection of views that are useful for a particular activity. With NSDEE you 

will use:

– NonStop perspective

– Debug perspective

• Eclipse View – A tabbed pane within a perspective. You can control which views are displayed, 

drag-and-drop views to different locations, and double-click a view‟s tab to maximize or minimize it.

• Eclipse Workspace – A container for organizing a collection of related projects. State that persists 

between eclipse sessions is managed on a per-workspace basis. NSDEE recommends against 

combining local and remote projects in the same workspace. 

• CDT – C/C++ Development Toolkit. Base eclipse framework that NSDEE builds on. 

Tip: CDT documentation is a useful reference

Key Concepts

Key Concepts

• NSDEE 2.0 had separate Eclipse perspectives for

– Local development – NonStop Local

– Remote development – NonStop Remote

• Issues

– Functional differences between perspectives

– Interface differences between perspectives

– More complex usage model

• Solution

– Unify perspectives into a single NonStop perspective capable of supporting local and remote development

– Leverage Eclipse File System (EFS) capabilities to enable improved functionality with remote files

26 ©2011 Hewlett-Packard Development Company, L.P

Unification of Local and Remote Perspectives

Key Concepts
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Step 0: Open the NonStop Perspective

Key Concepts

28 ©2011 Hewlett-Packard Development Company, L.P

The NonStop Perspective

NonStop 
Project View

Source editor(s)

Outline view

Make target
view

Problems view Console view

Current 
perspective

NSDEE tools

Richer set
of icons, 
including
error & 
warning
decorations

Local

Remote

Key Concepts
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Project Creation

29
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Creating Local Projects

Optionally configure NonStop cross-compilers

Project Creation: Local
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Creating Local Projects (cont‟)

Optionally set environment variablesOptionally set make options

Project Creation: Local

32 ©2011 Hewlett-Packard Development Company, L.P

Or import an existing project

1

2

Project Creation: Local   
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Creating Remote Projects
Example

Project Creation: Remote

NSDEE 2.1 Improvements
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Remote Projects

• Improved usability and integration

– Error and warning decorators

– Remote Project menu replaced by standard 

project menu

– Copy/paste supported between local and 

remote projects

– Remote projects now uses standard 

New File and New Folder commands and 

wizards.

• Unused Navigation view has been 

deleted

Project Creation: Remote
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Guardian virtual file extensions
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• Default file type defined at project creation

• NSDEE 2.1 lists a “virtual file extension” for 

Guardian files to identify their type

• Can use Open With… to open a different 

language editor 

Remote Projects

Project Creation: Remote
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• You can now mix local and remote projects in a single Eclipse workspace

Note: best practice is for workspaces to group logically related projects

• Deleting a remote project now displays a standard Eclipse dialog

– Note: Selecting delete project contents will NOT delete NonStop hosted files. 

Project Considerations

Project Creation: Remote
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Development Workflow

37

EditBuildDeployDebug
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Editors

Tip: double 
click  tab to 
maximize or 
minimize

Syntax errors 
listed for 
C/C++

Language  
elements are 
color coded

Less “language
awareness” for 
COBOL and
pTAL

EditBuildDeployDebug
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Using Templates 

• Window->Show View->Other…

• Generate 

recurrent

text

• Can be 

parameterized

Create
Insert

Edit

EditBuildDeployDebug

40 ©2011 Hewlett-Packard Development Company, L.P

• Eclipse provides many

configuration options

• Window->Preferences

• Tip: To display line numbers
General->Editors->Text Editors

• Language specific configuration 

presently not supported for COBOL or 

pTAL.

Configuring editors

EditBuildDeployDebug
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Development Workflow

41

EditBuildDeployDebug

Invoke build command

42 ©2011 Hewlett-Packard Development Company, L.P

• Build commands disabled when Build Automatically is checked

• Invoke Build Project command from either

– Right-mouse button menu

– or Project menu

• Other operations

– Clean project – invokes clean step 

– Deploy project – invokes deploy step

• Project properties make settings control the mapping 

of operations to make targets and the environment 

variables passed to the build.

Building projects

EditBuildDeployDebug
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Viewing build output
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• Raw build output is listed in the Console view

Building projects

EditBuildDeployDebug

Correcting build errors and warnings

44 2011 Hewlett-Packard Development Company, L.P

• Errors and warnings are listed in the Problems view

• Double click on an entry to position at the corresponding source location

• Editor lines annotated to mark problems

• Project view files annotated to mark problems

• Improved remote build error navigation

Building Projects 

EditBuildDeployDebug
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• Use the Make Target view to 

define and invoke custom make 

targets

• Note: Cannot add targets for 

Managed make projects

Make Target view

EditBuildDeployDebug
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• Select Convert To Standard Make from 

NonStop Projects view context menu*

• Benefits:

o User control over makefile

o Fine-grained control of build process

o Path for ETK migration to Standard Make

Converting Managed Make to Standard Make

EditBuildDeployDebug

*Note: Conversion cannot be reversed. 
Consider creating a workspace copy.
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• Standard make recommended for large projects

• Managed make

– Not supported for remote projects

– Will be superseded by use of CDT build mechanisms

• Remote project builds

– OSS projects use OSS make by default 

– Guardian projects use GMAKE by default

Build Considerations

Project Creation: RemoteEditBuildDeployDebug

Development Workflow

48

EditBuildDeployDebug
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• Define a connection:
NonStop Tools  Configure Connections…

– Specify the system

– Specify user

– Select protocol

– Click: Connect

Defining a NonStop Connection

Connection information is stored per 
eclipse Workspace. You can export 
and import configurations between 
workspaces

EditBuildDeployDebug

• Defines how to launch (run or debug) a 

project‟s executable 

on the NonStop 

system

1. Create

– Invoke Debug Configurations…

– NonStop Application

– Complete required fields

– Optionally specify additional info

2. Apply and Close

50 ©2011 Hewlett-Packard Development Company, L.P

Creating a Launch Configuration

Copy local executable to NonStop

EditBuildDeployDebug
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1. Open the Run Configuration

2. Click Run

3. View output in console window

Launching a Program on a NonStop Server

1

2

3

EditBuildDeployDebug
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1. Launch the Debug Configuration. 

Either:

• Select previously used configurations from the menu

• Or select from the Debug Configurations… dialog

Launching a Program in the Debugger

EditBuildDeployDebug
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Development Workflow

53

EditBuildDeployDebug
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• Focus: debug phase of the IDE workflow

– Debugs eclipse-built applications during development

– NSDEE is not yet a stand-alone or production debugger 

– Does not yet support some NonStop debugging features (info opens, …)

• Supports debugging C, C++, and COBOL on Integrity NonStop systems

• Recommend compiling at optimization level O0 during development

• Uses Native Inspect as “back-end” 

• Some Debug Perspective features are not available with NonStop

– Watchpoints, Step Filters, …

• Controlling GUI update/step performance

– Use debug configuration to set defaults

– Enable/disable items

NSDEE Debugging

EditBuildDeployDebug
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The Debug Perspective

EditBuildDeployDebug

Stack
View

Source
View

Execution Control

Consoles

Variables Breakpoints

Current
loc
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Session and Execution Control
• Execution control

– Resume, Suspend, Step in, Step Over, Step Out

– Run To Line

• Right Mouse menu operations

– Run To Line

– Resume At Line

• Attach to a running process

using a NonStop Attach Process Debug 

Configuration

• Session control

– Stop

– Disconnect

Must have consistent register state

Make sure target line is selected

Process Browser

EditBuildDeployDebug
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Breakpoints
• Setting code breakpoints

– Click breakpoint column in source view

– or use Right Mouse: Toggle Breakpoint

• Breakpoints View lists breakpoints

• Enable/disable breakpoints

• Breakpoint properties

• Breakpoints persist 

per-workspace 

between sessions

• Can import/export

Remove

EditBuildDeployDebug
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• Displays local variables for selected stack frame 

• Displays specified globals

– Add

– Remove

• Changed values are highlighted 

• Operations

– Expand/collapse

– Enable/disable

– Cast To Type…

– Display As Array…

– Change Value…

– Format 

• Can also display C/C++ variables using the 

mouse pointer in the source view

Variables View

EditBuildDeployDebug
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• Displays specified variables and 

expressions

• To add an expression either

– Right Mouse: Add Watch Expression…

– or drag-and-drop text from source view

– or drag-and-drop an item from the variables 

view

• Expressions are reevaluated in the 

current context each time the 

program is suspended

Expressions View

EditBuildDeployDebug
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• Debug view displays

– Program execution stack

– Debugger process

– Process being debugged

• Modules view displays DLLs (shared libraries)

• Signals view not supported in this 

release

Other Views

EditBuildDeployDebug
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• Disassembly view

• Step instructions

• Instruction breakpoints

• Memory view

– Monitors display memory 

in different formats

– Modify memory

– Changes highlighted

Machine-level Debugging (1of2)

EditBuildDeployDebug
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• Registers view

– Enable/disable to control performance

– Changes highlighted

– Operations

• Change value…

• Cast To Type…

• Create Watch Expression…

• Format…

Machine-level Debugging (2of2)

EditBuildDeployDebug
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• A sub-set of Native Inspect commands can be entered from the debugger 

console

• b location

• catch load|unload|stop|abend

• info open

• ih and mh

• mab and dmab

• print

• save

• Vq

1. Click debugger Debug view item 

2. Enter command in Console view

Console Commands

EditBuildDeployDebug
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• NSDEE debugging only supported on Integrity NonStop servers

• pTAL debugging currently not supported

• You can define launchers to

– Attach to a running process

– Debug a process snapshot file

Debugging Considerations

EditBuildDeployDebug
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NSDEE NEXT STEPS

FORWARD-LOOKING STATEMENTS

This document contains forward looking statements regarding future operations, 

product development, product capabilities and availability dates. This 

information is subject to substantial uncertainties and is subject to change at any 

time without prior notification. Statements contained in this document 

concerning these matters only reflect Hewlett Packard's predictions and / or 

expectations as of the date of this document and actual results and future plans 

of Hewlett-Packard may differ significantly as a result of, among other things, 

changes in product strategy resulting from technological, internal corporate, 

market and other changes. This is not a commitment to deliver any material, 

code or functionality and should not be relied upon in making purchasing 

decisions.

This is a rolling (up to three year) Statement of Direction and is subject to change without notice .

66 ©2011 Hewlett-Packard Development Company, L.P
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• On-going

– Support growing installed base 

– Support current software versions

– Continue to improve “out-of-box” experience

– Continue to improve Eclipse integration

NSDEE Next Steps

• Medium-term

– Windows 7 support

– Enable and support ETK migrations

– Interoperate with NonStop Samba

– Leverage CDT build mechanisms

– Improve NonStop SQL support

• Long-term 

– Utilize Eclipse DSF to provide improved 

debugging

• Debugging non-NSDEE created programs

• NonStop initiated debug requests

• NonStop specific debugging 

Next StepsThis is a rolling (up to three year) Statement of Direction and is subject to change without notice.

67 ©2011 Hewlett-Packard Development Company, L.P
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• NSDEE extends the industry standard Eclipse IDE to support NonStop

– Builds on an IDE that is available for many platforms

– Offers a rich ecosystem of open source and third-party extensions

• NSDEE targets all NonStop development environments 

• NSDEE is the first NonStop IDE to support 

– NonStop hosted (“remote”) development

– Integrated debugging 

• NSDEE offers significant functional and integration improvements over EPE

• NSDEE is the future platform for NonStop IDE and debugger GUI enhancements

• NSDEE will continue to evolve

Summary

Next StepsThis is a rolling (up to three year) Statement of Direction and is subject to change without notice.
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SQL development using Eclipse Plug-in

69

Quantum Freeware

Eclipse + Quantum plug-in + NonStop JDBC Type 4 
driver (T1249)

- Install eclipse + GEF (Help, software updates, find and install, search for new 

features to install, select Sites to search, then in one of the sites select Graphical 

Editing Framework and install it according to instructions).

- Install Quantum plug-in (Help, software updates, find and install, search for new 

features to install, new remote site: name : quantum:

url: http://quantum.sourceforge.net/update-site

Installation

DataSource 
definition

Test

- Open Quantum perspective

- click new database bookmark

- add driver, add the external jar & browse to the jar file location, 

- click browse and select to select the class name which is resolved automatically for 
you

- Enter user id; password and url and name the bookmark

- Select previously created bookmark and click connect



12 September 2011HP Confidential 36

Eclipse + Quantum plug-in + type 4 driver

Eclipse + Quantum plug-in + type 4 driver
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Eclipse + Quantum plug-in + type 4 driver

Eclipse + Quantum plug-in + type 4 driver
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And Now, The Demo

DDL - Completing the puzzle of workstation 
development

76

A Workstation-based DDL compiler 
for ECLIPSE by Nexbridge

http://www.nexbridge.com/Default.htm
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What It Is

• ECLIPSE-based plug-in

• DDL text editor

• Compiler

• No connectivity requirements

Host-Based Process

Compile 
Program

Debug

Program

Change 
DDL

Compile 
DDL

Change 
Program
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NSDEE Process with DDL

Upload 
DDL

Compile DDL
Download 
Libraries

Debug 
Program

Change 
DDL

Change 
Program

Compile 
Program

Deploy

On Workstation On Host

NSDEE Process with NskDdl

Compile 
Program

Deploy

Debug

Program

Change 
DDL

Compile 
DDL

Change 
Program
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What It Has

• Standard DDL syntax

• Run-anywhere Java 1.6 implementation

• Workstation to Guardian file mappings

• DEFINE mapping support

• Batch mode execution

• Speed

• Convenience

Language Support

Standard Languages

• C

• COBOL

• TAL

• FUP

• TACL

Extension Languages

• Java (ddl2java)

• XSD

• WSDL

• Documentation Website

• EGI (in progress)

• More to come…
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ECLIPSE Support

• Helios

• Integrated Problem Markers

• Integrated TODO Markers

• Color coding

• Local file support

• Build-on-save integration

• Annotations (e.g., @Deprecated)

Some Differences

• No dictionary

– Contents not preserved between compiles

– Fast compiles make this acceptable

• No PASCAL or BASIC support
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Key Usage Scenarios

• “Keep source compatible”

– Use file name mapping to GUARDIAN files

• “Always compile on workstations”

– Local path names in sources

And Now, The Demo

More information www.nexbridge.com

http://www.nexbridge.com/
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We want

Happy Customers

Next Steps

88 ©2011 Hewlett-Packard Development Company, L.P

We Value your Feedback

Next Steps

• We are always interested in your feedback

• Especially on:

– ETK migration impediments

– Importance of pTAL debugging support

– NonStop SQL needs

– Importance of improved COBOL and pTAL editing support

– The Importance of Linux hosting?

– Additional debugging capabilities

• Take our survey!
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• NSDEE Product Page

– www.hp.com/go/nsdee

• Demo Videos  on 

– NSDEE 2.1 update 

– Introducing NonStop Development Environment for Eclipse (NSDEE)

– NonStop Development Environment for Eclipse (NSDEE) Hello NSDEE Demo

– NonStop Development Environment for Eclipse (NSDEE) Local Projects

– NonStop Development Environment for Eclipse (NSDEE) Remote Projects

– NonStop Development Environment for Eclipse (NSDEE) Debugging

Resources

Next Steps
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• NSDEE Software

– Trial version: 

https://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HSB98V1

(or via www.hp.com/go/nsdee)

– Order:

• HP NonStop Development Version 2.1 for Eclipse - Core (NSDEE 2.1 - Core)

– Product #: SB99V1, QSB99V1, HSB99V1

• HP NonStop Development Version 2.1 for Eclipse - Core with Debugging (NSDEE 2.1 - Core with Debugging)

– Product #: QSB98V1, HSB98V1

• Eclipse

– www.eclipse.org

– www.eclipse.org/cdt

Resources

Next Steps

http://www.hp.com/go/nsdee
https://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HSB98V1
http://www.hp.com/go/nsdee
http://www.eclipse.org/
http://www.eclipse.org/cdt
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THANK YOU
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This document contains forward looking statements regarding future 
operations, product development, product capabilities and availability 
dates. This information is subject to substantial uncertainties and is subject to 
change at any time without prior notification. Statements contained in this 
document concerning these matters only reflect Hewlett Packard's predictions 
and / or expectations as of the date of this document and actual results 
and future plans of Hewlett-Packard may differ significantly as a result of, 
among other things, changes in product strategy resulting from 
technological, internal corporate, market and other changes. This is not a 
commitment to deliver any material, code or functionality and should not be 
relied upon in making purchasing decisions.


